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Chapter 836 

Reliability 
Demonstration Tests 
of One Proportion 
with Adverse Events 
Introduction 
This routine calculates the sample size needed for a reliability demonstration test based on the binomial 
distribution. These tests may be conducted by comparing a one-sided confidence bound for a proportion and with 
a pre-determined reliability standard or by comparing the number of adverse events to a calculated minimum 
value. It may be used to find a sample size and/or power for studies of rare events. 

Power Not Used 
This is one of the few procedures in PASS in which the sample calculation does not use power. Instead, a value 
for power is implied by the specified value of the maximum number of adverse events. Optionally, the power of 
the design can be calculated. 

Technical Details 
This procedure is primarily based on results in Guenther (1977), Hahn and Meeker (1991), and Abernethy (2006). 
Conceptually, the test compares the number of adverse events to a critical value which is chosen to guarantee a 
certain significance level. The sample size formulas are based on using an exact binomial test of one proportion.  

A binomial variable should exhibit the following four properties: 

1. The variable is binary --- it can take on one of two possible values. 

2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial. 
The number of replications is n. The number of times that the outcome of interest is observed is r. Thus, r 
takes on the possible values 0, 1, 2, ..., n. 

3. The probability, P, that the outcome of interest occurs is constant for each trial.  

4. The trials are independent. The outcome of one trial does not influence the outcome of the any other trial. 
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A binomial probability is calculated using the formula 

( ) ( )b r n P
n
r

P Pr n r; , =





 − −1  

where 

( )
n
r

n
r n r






 =

−
!

! !
 

Following Guenther (1977) define the cumulative binomial as 
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The minimum sample size is found by finding the smallest value of N the obeys the inequality 

𝐵𝐵𝐵𝐵(𝑐𝑐;𝑁𝑁, 1 − 𝑃𝑃𝑀𝑀𝑀𝑀𝑀𝑀) ≤ 𝛼𝛼 

The power of this test may be calculated using 

𝐵𝐵𝐵𝐵(𝑐𝑐; 𝑁𝑁, 1 − 𝑃𝑃𝑇𝑇𝑇𝑇𝑇𝑇𝑇𝑇) = 𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 

where power  is the probability of a successful demonstration, PMIN is the reliability standard that must be met, 
and PTRUE is the reliability value at which power  is calculated. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
Select the parameter you want to solve for. The parameter you select here will be shown on the vertical axis in the 
plots. 

Sample Size 

A search is conducted for the minimum sample size that adheres to the parameter values. 

Alpha 

The probability of a successful demonstration when the population is actually unreliable. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at random from the 
population to be in the study. 

You can enter a single value or a range of values. 
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Alpha and Maximum Adverse Events 

Alpha 
Specify alpha, the probability of concluding reliability when in fact the object under study is not reliable. 
Reliability is defined as the probability of a success. 

In this procedure, one minus alpha is interpreted as the confidence level of a one-sided confidence bound for the 
reliability. The demonstration test is may be carried-out by comparing a one-sided lower confidence bound of the 
reliability to a specified minimum requirement (Pᴍɪɴ). If the confidence bound is larger than Pᴍɪɴ, reliability is 
demonstrated. 

The demonstration test may also be carried out by noting whether the number of adverse events is less than or 
equal to c, the maximum allowed adverse events. Alpha ranges from 0 to 1. Typical values range from 0.001 to 
0.02. 

You can enter a single value such as 0.05 or a series of values such as 0.1 0.05 0.01 or 0.05 to 0.20 by 0.01. 

C (Maximum Adverse Events) 
This is the number of nonconforming events that are tolerated while still concluding a successful demonstration. It 
is sometimes called the maximum failures allowed. If the number of adverse events in the study is greater than c, 
reliability is not demonstrated. Otherwise, it is. 

You can enter any non-negative integers. Often, a value less than 5 is used. 

You can find the sample size for a zero-acceptance study by entering a zero here. 

Reliability 

PMIN (Minimum Reliability) 
Enter Pᴍɪɴ, the minimum reliability (proportion of population conforming) that has been set as the standard or 
requirement. If the lower confidence bound of the proportion conforming computed from the study is greater than 
Pᴍɪɴ, reliability is demonstrated. Otherwise, it is not. 

The range of calculation is 0 < Pᴍɪɴ < 0.999999. Above 0.999999, the calculations become unstable. Typical 
values range from 0.8 to 0.999. 

Often, one of the values 0.80, 0.90, 0.95, 0.99, 0.999, or 0.9999 is used. 

You can enter a single value such as 0.9 or a series of values such as 0.9 0.95 0.99 or 0.8 to 0.95 by 0.01. 

Calculate Power (Probability of a Successful Demonstration) 
Check this option if you want to calculate the power. Note that calculating power will not impact the parameter 
solved for (Sample Size or Alpha). 

If you want to calculate power, you will need to enter a value for Pᴛʀᴜᴇ. 

True Reliability (PTRUE) 
Enter Pᴛʀᴜᴇ, the assumed true value of the reliability (proportion of population conforming). This is the value of P 
used to calculate power in the binomial probability distribution. 

The permissible range of Pᴛʀᴜᴇ is Pᴍɪɴ < Pᴛʀᴜᴇ < 1. Typical values range from Pᴍɪɴ to 0.999. 

You can enter a single value such as 0.95 or a series of values such as 0.9 0.95 0.99 or 0.8 to 0.95 by 0.01. 
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Example 1 – Calculating Sample Size  
Suppose a study is planned to determine the sample size required for a reliability demonstration study for values 
of c from 0 to 4. The other values are Pᴍɪɴ = 0.9 and Alpha = 0.05. 

Setup 
This section presents the values of each of the parameters needed to run this example. First load the Reliability 
Demonstration Tests of One Proportion with Adverse Events procedure window. You may then make the 
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alpha ....................................................... 0.05 
C (Maximum Adverse Events) ................ 0 1 2 3 4 
PMIN ......................................................... 0.9 
Calculate Power ...................................... Not Checked 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for the Reliability Demonstration Test using a Fixed c 
Solved for Sample Size 
    Maximum 
Minimum   Sample Adverse 
Reliability Target Actual Size Events 
Pᴍɪɴ Alpha Alpha N c 
0.9000 0.050 0.047 29 0 
0.9000 0.050 0.048 46 1 
0.9000 0.050 0.049 61 2 
0.9000 0.050 0.047 76 3 
0.9000 0.050 0.050 89 4 
 
References 
Abernethy, Robert B. 1996. The New Weibull Handbook, Second Edition. Robert B. Abernethy, Florida. 
Guenther, William C. 1977. Sampling Inspection in Statistical Quality Control. Griffin’s Statistical 
   Monographs, Number 37. London. 
Hahn, G. J. and Meeker, W.Q. 1991. Statistical Intervals. John Wiley & Sons. New York. 
Meeker, W.Q. and Escobar, L.A. 1998. Statistical Methods for Reliability Data. John Wiley & Sons. New York. 
 
Report Definitions 
Minimum Reliability, Pᴍɪɴ, is the reliability standard. It is the required proportion conforming. 
Alpha is the significance level of this one-sided test. It is the probability of rejecting the null hypothesis of 
   unreliability when it is true. The demonstration test is carried-out by comparing a one-sided lower confidence 
   bound of the reliability with a confidence level of one minus alpha to a specified minimum requirement (Pᴍɪɴ). 
   If the confidence bound is larger than Pᴍɪɴ, reliability is demonstrated. 
Target Alpha is the significance level the design is meant to achieve. 
Actual Alpha is the significance level the design actually achieves. It is calculated using Pᴍɪɴ. 
Sample Size, N, is the number of subjects in the study. 
Maximum Adverse Events, c, is the number of nonconforming events that are tolerated while still concluding a 
   successful demonstration. It is sometimes called the 'maximum failures allowed.' 
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Summary Statements 
A test of a single proportion is used to demonstrate conformance with a minimum reliability 
standard of 0.9000. The study sample size is 29. The target significance level is 0.050. The 
significance level actually achieved is 0.047. The maximum number of adverse events allowed 
with a successful demonstration is 0.  
 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

    
 

This plot shows the sample size for various value of c. 
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Example 2 – Validation using Abernethy (1996) 
Abernethy (1996) page 8-5 presents a table of sample sizes when c, the number of failures, is zero. One line of the 
table is for Pᴍɪɴ = 0.99 and various confidence level values from 0.5 to 0.9999. These confidence levels are 
transformed into alpha values using alpha = 1 – confidence level. The resulting sample sizes are 69, 92, 120, 161, 
230, 299, 459, 688, and 917. 
To show off the additional capabilities of PASS, we will also display the power when PTRUE = 0.999. These results 
are not available in Abernethy (1996), but they are very enlightening. 

Setup 
This section presents the values of each of the parameters needed to run this example. First load the Reliability 
Demonstration Tests of One Proportion with Adverse Events procedure window. You may then make the 
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example 
Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alpha ....................................................... 0.0001 0.001 0.01 0.05 0.1 0.2 0.3 0.4 0.5 
C (Maximum Adverse Events) ................ 0 
PMIN ......................................................... 0.99 
Calculate Power ...................................... Checked 
PTRUE ....................................................... 0.999 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for the Reliability Demonstration Test using a Fixed c 
Solved for Sample Size ignoring Power 
      Maximum 
Minimum True    Sample Adverse 
Reliability Reliability Target Actual  Size Events 
Pᴍɪɴ Pᴛʀᴜᴇ Alpha Alpha Power N c 
0.9900 0.9990 0.0001 0.0001 0.3995 917 0 
0.9900 0.9990 0.0010 0.0010 0.5024 688 0 
0.9900 0.9990 0.0100 0.0099 0.6318 459 0 
0.9900 0.9990 0.0500 0.0495 0.7414 299 0 
0.9900 0.9990 0.1000 0.0991 0.7944 230 0 
0.9900 0.9990 0.2000 0.1983 0.8512 161 0 
0.9900 0.9990 0.3000 0.2994 0.8869 120 0 
0.9900 0.9990 0.4000 0.3967 0.9121 92 0 
0.9900 0.9990 0.5000 0.4998 0.9333 69 0 
 

Note that PASS found the same sample size values as Abernethy (1996). Also note that the computed power of 
these designs shows that those with an alpha of 0.05 or less are under-powered (power < 0.8). 
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